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November’s Meeting

December’s Meeting
The December general
meeting will be the
Annual Year/Millennium-end Party: LIMac’s
last meeting of the millennium! There will
be Q&A session and a
short game demo, but
no SIG meetings.
LIMac will bring
tableware, coffee and
soft drinks and a big
sheet cake, but we need your help for the
main event.Bring tasty stuff. No alcoholic beverages. Bring whatever you think is great and
want to share with everyone else. Bake
your best recipe. Go to that bakery
that makes the best item. But lets have
some healthy/vegetarian foods, too. Someone
should make a killer salad. Some nice
fruit salad is always nice. Maybe some
carrots and cucumber and a dip. Show off
your talents in the kitchen. Let’s make this a
party one for the taste buds to remember.
The election of our officer nominees for
the year 2001 will also be on the agenda.
The nominees for office are:
President – Bill Medlow
Vice President – Al Choy
Treasurer – Max Rechtman
Secretary – Bernie Flicker 0
Friday, December 8th, 7 p.m., Building 300,
The New York Institute of Technology.
LIM

Desmond Lee from Olympus came down,
and brought a selection of digital cameras for
us to examine. Unlike it’s prime competitor,
Nikon, Olympus makes a wide range of digital
cameras because customers have a wide range
of needs and therefore require a wide range
of cameras at price points and feature
compromises.
A good example would be
the new C-2100UZ shown above
on the left. It has a 10X optical
zoom with optical image stabilization, but 2.1 megapixels.
Compare that to the
C-3030 Zoom above
on the right, with
3.34 megapixels, 3X
zoom but fast 3.3
frames/sec sequence
mode shooting.
Another specialty
camera is the new
C-211 Zoom printing
camera which uses
Polaroid type 500 film.
Comes with 3X zoom
with macro mode to 8
inches. 2.11 megapixels
is large enough for an 8- by 10-inch print back
at the office.
Also featured in the discussion was the
new Camedia E-10 4 megapixel SLR . At $2000
list, it’s a professional’s camera, but it
features a fast f 2.0 lense especially designed
for digital camera use, a pivoting display
and can use both SmartMedia and
CompactFlash cards. Real manual focus
and a shutter lag of under 100 msec.
Even a trusty hot shoe on top. An allaluminum body means it’s rugged and
dissipates internally generated heat. It beats
the Nikon D1 in features and price. 0
–Bradley Dichter
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The Internet SIG: The Internet SIG meeting will be held at the Bethpage
Public Library (516-735-4113) on Monday, December 17th at 8 p.m.
SIGs immediately after the general meeting:
Beginners SIG: No meeting this month. See you in January!
Mac Help SIG: No meeting this month. See you in January!
DTP/Photoshop SIG: No meeting this month. See you in January!
Business SIG: Disbanding due to
lack of member interest.
Mutimedia SIG: No meeting this
month. See you in January!
x LIMac meetings, unless otherwise
noted, are held in Building 300
(Anna Rubin Hall) at the New York
Institute of Technology on Northern
Blvd. in Old Westbury.
| In bad weather, call 516-686-7789.
| The next LIMac board meeting
will be at the Plainedge Library
( 516 -931-3907) on Wednesday,
December 13, at 8 p.m.
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LIMac will be documenting its history.
At LIMac’s final General Meeting of the

TIP!
QXP 4: Tips’n’Tricks.
A Miscellany:
| Creating ViewSpecific Guides:
Shift-Drag a guide
from the ruler to make
it visible at only that
percentage view or
greater (i.e., ShiftDrag a guide while at
200% view to make
the guide visible only
at 200% or above).
To Shift-Drag, simply
hold down the Shift
key while you click
on a ruler and drag
out a guide. You can
confirm that your
guide is visible at only
your current view
percentage or higher
by lowering the view
percentage and
looking for the newly
created guide.
| Unlinking a text box:
Unlink a text box
from a story without
breaking the story flow
by Shift-Unlinking the
box.
–Jan Klimper

Millennium, which will be Friday evening,
December 8th, 2000, we will have our Q&A
session (with Bradley), followed by a short
presentation, the monthly raffle and our
end-of-the-year holiday party, (don’t forget
to bring the whole family. they’re all members, too). All of the aforementioned will be
recorded on digital video by some of our
members.
These digital video recordings will be
turned into LIMac’s first QuickTime ® movie
to be created with Apple’s new video software
iMovie2. It will be premiered on December
16th, at the MicroCenter Computer Store
on Merrick Avenue in Westbury. We will be
doing this live, projected onto a large screen,
so all present can easily see how quickly this
can be accomplished.
This would not be possible without the
help of Rick Johnson and Tommy Gannon.
There will be some surprises. And come early
since seating is limited.
Happy New Millennium! It’s “deja vu all
over again.” 0
Fractals discount offer.
All LIMac Members can receive a discount
on Genuine Fractals and on Genuine Fractals
PrintPro through:
Jody Grober
Roberts Distributors
255 South Meridian
Indianapolis IN 46225
317-636-5544

info@robertsimaging.com
Just ask Jody for the Dan Discount !
Larger discounts are available for orders in
groups of four or more.
0

Technical Corner
| I got an advertisement from a car company in the form of a cut down mini-CD
the size of a business card. Can I use that
in my iMac or iBook?
These discs are cut down to fit a business
card’s dimensions. They hold 50MB of data.
The iBook, with it’s tray loading mechanism
where the CD center hole snaps onto the
spindle, can handle these as well as the small
round CD-ROMs, but the slot loading iMac
will likely never eject the disc and it would
require service to get it out or replace the
drive. The small 77 mm diameter round discs
also will not work in the slot loading iMac.
Only the full size 120mm discs will work. The
G4 Cube would also have the same problem
as the slot load iMac. The slot loading
drive is unusual in the computer industry
so manufacturer’s using these discs as well
as recordable versions are not aware of
the problem. I see the PokeROM discs
at the checkout corner of CompUSA and
I notice they would work on the Mac OS , but
be warned iMac buyers!
| I’m running Mac OS 8.1 and I’ve recently
added a lot more RAM and now the Mac
takes a long time from the moment I press
the Power Button to the time it starts up. I
know it’s testing the Memory. Is there any
way to prevent it from taking so long?
You would have to upgrade to Mac OS 8.6
or newer to be able to use the trick of the
Memory Control Panel to disable the Memory
Test.
| On my 400MHz PowerBook G3 (FireWire), is there a difference between the
USB ports and between the FireWire ports?
The FireWire ports are treated exactly the
same, but USB port 2, the lower port, is the
preferred one with higher priority. Best for
external keyboards as it allows you to use the
Shift or C keys to start up without Extensions
or from a bootable CD.
| Is the dual processor G4 worth it? I do
imagesetter work.
Then I would assume you do heavy Photoshop
work, in which case I would say the dual
450MHz with Max R AM would be far better
than 500MHz with not enough. The speed
benefit, about 60% and the additional base
R AM and bigger hard drive are worth the
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Bradley Dichter
bdichter@cdr.net

TIP!
Control blends in
Illustrator 8:
In Illustrator 8, you
can control a blend’s
rate of change by
manipulating the
direction points of
its spine. Click the
center of the blend
with the Direct
Selection tool, then
select the Convert
Direction Point tool
and drag out the
a control handle at
each end of the spine.
As you move these
control handles, you
will adjust the blend’s
rate of change.
–Macworld

URL Manager Pro 2.5
Are you constantly switching from Netscape to
Internet Explorer? With the way browsers act
these days you probably do a bunch of switching
around. Unfortunately switching browsers isn’t
exactly the easiest thing to do. Mainly because you
have to transfer bookmarks from one browser to
another. It may be easy to do, but it becomes a
real pain after awhile. URL Manager Pro solves
that problem and offers some great enhancements.

URL Manager Pro manages all your bookmarks in one program. The reason I like URL
Manager Pro the best is because of its interface. The program allows you to create folders
for each category of your choice (i.e. Mac
Websites). You then have the option of adding
individual URL’s to each folder. You can even
add sub-folders. The program integrates with
your current Web browser so you don’t have
to jump back and forth between applications
to paste new URLs. The program also supports

the-mail, and ftp URL protocol. One of the
nicer features of the bookmaking system is the
ability to place notes with each URL. By highlighting a bookmark and pressing Command-I,
you have the option to place your own notes
about the selected site.
Powerful Features: URL Manager Pro
offers loads of great features such as
History. It keeps track of past sites that you
visited. Another key feature of the program
is Bookmark Management. On the Web, sites

come and go, and most people don’t have the
time to check their bookmarks regularly. URL
Manager Pro can automatically check for dead
URL’s. The program also has a built in Net
Search.
The program can be purchased and
downloaded from www.url-manager.com. for
$25.00. 0
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More Technical Corner

TIP!
Use Retrospect for
quick duplicates:
Retrospect is used to
automatically back up
a computer to a tape
drive or other removable media drive. But
it also provides a
very fast way to copy
all data from one
volume to another
(much faster than
using the Finder).
For example,
files copied to a
100MB Zip cartridge
using the Finder, proceeded at .5MB per
minute. Retrospect
copied the data at
6MB per minute –
about 12 times
faster. Use
Retrospect to
quickly duplicate
one Hard Drive to
another, then
reformat the first
Hard Drive, and use
Retrospect to
quickly copy the
data back
to it.
–Design Tools Monthly

extra cost. Mac OS X will be able to allow one
program to use processor A, while a second
program will get processor B and never a
slow down when a program is switched to
the background or when your downloading
or holding down the mouse button.
| I have a G4 with font problems. I originally had Extensis Suitcase 8.2. A service
installed 8.0 and removed Type Reunion
Every font is now open. It’s a mess. What
should I do?
First, you could try downloading Suitcase 8.2
with MenuFonts 8.2.2 with the MenuFonts
update. Then, with that installed, move your
non-essential fonts from the System Folder
and manage them with 8.2 with MenuFonts
8.2.2. If your G4 is running Mac OS 9.0, then
you should upgrade to Suitcase 9.0.1.
Personally, I would toss Suitcase and
MenuFonts and use Adobe Type Manager
Deluxe and Type Reunion Deluxe. ATM
Deluxe can auto-activate in any program, not
just Quark XP ress, plus it has dependable
Verify and Find Duplicates functions. If you
use ATM Lite with Suitcase or ATM Deluxe
without, if your G4 is running Mac OS 9, it
comes with an Extension called Type 1 Scaler,
which needs to be removed. If you are using
Mac OS 9 and the Multiple User software to
create a limited user, then Suitcase 8.2 won’t
work and you’ll have to use Suitcase 9.0.1 (or
better yet ATM Deluxe 4.6.1.)
| I have a G4 450MHz using Mac OS 8.6.
Every time a startup I have to go to the
Chooser to select my Epson Stylus Color
600. Also the queue has stopped working –
print jobs never get printed.
Have you tried zapping the Parameter RAM ?
The Stylus Color 600’s software has not seen
an update in two and a half years. You need a
USB adapter to work it with a G4. You never
will find peace with this printer. I would suggest replacing it with a cheap newer Epson
like the $99 Stylus Color 777 which has
native USB connection. You’ll have to get a
USB A to B cable to go with it. Consider
moving up to a better printer in the Epson
line, they all have USB now. The software
is modern and you’ll have far less problems
with that. For people with older Macs that
still had printer ports, the old Epson soft-

ware suffered the problem where it did not
set the PRAM with the selected port. You had
to use the Apple StyleWriter or ImageWriter
software to pretend you had one of those connected to the Printer port, close the chooser,
which set the PRAM, then open it again and
choose your Epson printer. The only option
besides this was to leave the printer on the
modem port and connect your modem to the
printer port and change the settings of your
modem using software, like the PPP/Remote
Access software, or AOL’s setup. Very old prePower Macs would not support the swap, as
the two serial ports were not interchangeable.
| My G4 wakes up immediately after I tell
it to go to sleep. What causes this?
Usually it’s a USB device being polled, so
you could say it’s some software – and it’s
some hardware. With the assumption it’s a
USB device, unplug all but the keyboard and
mouse and tell the computer to sleep. If it
stays asleep, then wake it up, plug in one USB
device and try again. You should find the
culprit. Often it’s a scanner software (in the
Startup Items) checking for a button press.
I usually kill these and use the scanner conventionally. If the problem is software only,
I would use Conflict Catcher or Apple’s
Extensions Manager to figure out which software is causing the problem. You may need
to disable, downgrade or upgrade something.
Yes, sometimes the latest is not the greatest.
One other possibility is the power switch is
faulty. If so, you may smell a burnt aroma.
The G4 will have to go in for service. 0
(Sore Eyes continued from page 4)

Now the problems: We must connect the
Airport to the ISP with Airport software,
which means we must bring along the portable each weekend. I was able to find a thirdparty software patch which lets me disconnect
the Airport from the ISP, but cannot turn it
on without the Apple software. That’s my first
question for Bradley. The second one is: Can
I use a hub to attach more than one Ethernet
cable to the Airport base? 0

THE LIMAC FORUM/DECEMBER 2000

TIPS!
Photoshop
selection tips:
| Selection beyond
edge of document when
using the Lasso tool:
You can hold the
Command key to drag
beyond the edge of
your document and still
make a selection.
| Restrict selection to
Image Boundaries:
To limit the selection
to the edges of your
image, choose Select >
Inverse twice.
| Saved selections:
If you are going to need
to use a selection over
and over again, then
choose Save Selection
from the Select menu.
| To retrieve the selection later: Choose
Load Selection from
the same menu. These
saved selections will
remain in the file as
long as you use the
Photoshop or TIFF file
formats. To save the
image in any other
file format be sure to
choose File > Save
A Copy, otherwise the
other file formats will
not be available.
| Control-Click:
You can access many
of the commands that
appear under the
Select menu by ControlClicking while using any
of the selection tools.

Long Island Macintosh Users Group
Post Office Box 518
Seaford, New York 11783
www.limac.org
The December general meeting
will be the Annual Year/
Millennium-End Party: LIMac’s
last meeting of the millennium!
There will be Q&A session and a
short game demo, and election of
officers, but no SIG meetings. And
a digital movie shoot!

Friday, December 8th, 7 p.m.,
Building 300, The New York
Institute of Technology.
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Helen and
Sheldon Gross
shel9 @ bellatlantic.net
Note: These sites are
referred to by us for
your information only
and neither we nor
LIMac endorse any of
the products or sites.

Sore Eyes

User Group News

This is a good opportunity to discuss our experiences with Airport. Every time I open the
computer section of the newspaper or look
at another computer magazine, the discussion
seems to revolve around wireless Internet connections. We use Apple’s Airport and we think
it is wonderful. It was not so easy to set up
at first. However, now that Apple has updated
Airport to version 1.2, there seem to be no
difficulties, or at least very few.
We have an Airport card installed in the
iBook with which we travel. This is a $99
addition that is very easy to install. Just lift the
keyboard and the built-in clip appears.
We have a base station set up in our house.
This $299 purchase allows us to take the portable any place within 150 feet of the base.
Airport gets plugged into the telephone connection and that’s it. Airport software on the
portable allows us to connect to our ISP. We
have used as many as five individual Macs with
Airport cards at one time – all connected to
the Internet; all doing different things at the
same time. According to Apple, we can use
up to ten.
We even have my G3 Desktop attached
by Ethernet crossover cable to Airport. This
enables me to use the G3 while Shelly is using
the iBook, even though there is no Airport
card in the G3. Of course, we are limited to
the length of the cable but since I never move
the desktop mini tower, it doesn’t matter. My
granddaughter, who has a similar set up in
her own home in Virginia, has a 40-foot cable
which limits her somewhat, but she moves her
old 1400 portable within that distance. By the
way, if someone should dare to bring it up,
this connection can be used by a non-Mac.

It’s December and at LIMac we will once
again be hosting our annual holiday party. We
will supply all drinks, soda, coffee, and tea.
Please bring something with you that can be
shared with our members. We look forward to
seeing you and having a great meeting. The
User Group Network is presenting a holiday
gift guide of the hottest gifts of the season:
including Mac User’s Favorite Gift Ideas for
Palm Computing users, Digital Camera users
and anyone who has ever wished they had
the software manual: www.user-groups.net/
UGB ookshelf/index.html. Check out the MUG
Resource Center featuring many of the hottest Macintosh links of interest to Mac users:
www. user-groups.net/resources.
| The User Group Network presents the writings of Ken Fermoyle noted author, writer,
speaker and syndicated user group columnist.
Ken’s articles can be found at: Ken’s Korner:
www.user-groups.net/Fermoyle/. Interested in
the latest great shareware? Or, submit a shareware item that you think is terrific, if it’s
selected for listing on the UGN Shareware
Manager you will win a prize! Shareware
Manager: www.user-groups.net/ shareware/.
Want to read newsletters from User Groups
around the country? Newsletters: www.usergroups.net/news/newsletters.html. Interested in
the latest Mac rumors? Rumor Manager:
www.user-groups.net/Rumor Manager/. 0
Membership Drive for 2001 under way.
Your $26 dues check may be brought to the
meeting or mailed to:
Long Island Mac Users Group
P.O. Box 518
Seaford, NY 11783 0

(Sore Eyes continued on page 3)
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Max Rechtman
MaxLIMac@aol.com

TIP!
Fast printing in
Quark :
To speed up your
print time when
printing a proof of
a document with pictures, choose Low
Resolution or Rough
from the Output
pop-up menu in the
Print Dialog Box >
Options tab. When
Low Resolution is
selected, the 72 DPI
previews of the pictures are printed
instead of the highresolution images
themselves. When
Rough is selected, a
box with an “X” prints
in place of the picture,
and complex frames
print as simple ones.

